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Değerli Öğrenciler ve Araştırmacılar,  

Günümüzde özellikle mekanik ve ısıl sistemlere yönelik yapılan Ar-Ge  çalışmalarında tasarım ve 

analiz programlarının kullanılması bir zorunluluk; bunları kullanabilme becerisi ise bir ayrıcalık ve iş 

başvurularında önemli bir tercih sebebi haline gelmiştir.  

Yeni tasarlanacak  mekanik veya ısıl bir sistemin, makinanın, mekanizmanın veya parçanın çalışma 

şartlarındaki dış yüklere karşı vereceği tepkileri, imalata geçmeden önce hesaplayabilmek, sorunsuz bir 

tasarım açısından son derece gereklidir. Ancak sistemin kompleksliği arttıkça teorik olarak çözüm 

üretmek de o derece zorlaşmaktadır. Bu gibi durumlarda ise yaklaşık çözüm metodlarına 

başvurulmaktadır ki, bunların içerisinde en yaygını şüphesiz Sonlu Elemanlar Metodudur. Bu metodda 

sistem düzgün geometrik küçük elemanlara ayrılır ve çözüm çeşitli kabullerle bu sonlu elemanlar ağında 

gerçekleştirilir.  Sonlu elemanlar ağının büyüklüğü ne kadar fazla ise çözüm o derece zorlaşmakta ve 

mutlaka bilgisayarda probleme özel yazılım oluşturmaya ihtiyaç duyulmaktadır. Bu ise sonlu elemanlar 

teorisinin yanısıra Fortran, Basic, C++ gibi programlara oldukça hakim olmayı gerektirmektedir. 

Günümüzde ise Sonlu Elemanlar Teorisi temelinde çalışan ve görselliği de ön plana çıkaran Paket 

programlar sayesinde hemen hemen tüm sistemlerin analizleri yapılabilmekte ve çalışma şartlarındaki 

durumları hesaplanabilmektedir.  Ar-ge faaliyetlerinin artık vazgeçilmezi haline gelmiş bu programları 

kullanabilmek için sonlu elemanların teorisini bilmeye de çok gerek kalmamaktadır. Mühendislik 

öğrencilerinin bu programlara şimdiden aşina olmaları ve mümkün olduğunca kullanma becerilerini 

geliştirmeleri ise ilerideki kariyerleri açısından son derece etkilidir.    

Bu paket analiz programları içerisinde  ülkemizde ve dünyada en yaygın kullanılanlardan birisi 

şüphesiz ANSYS programıdır.  İşte bu notlarımızı ANSYS’in yeni arayüzü olan WORKBENCH’e yeni 

başlayanlara yönelik hazırladık ve  sağlam bir ilk adım atmalarını hedefledik. Bu notlarımızı hızlı bir 

şekilde tamamlayarak hem Ansys-Workbench kullanımı hakkında bir aşinalık, hem de daha ileri 

seviyedeki çalışmalarınızda kendi başınıza gerekli içeriği öğrenebilme becerisi elde edebileceksiniz. 

Şunu da unutmamak gerekir ki, bir mühendisin  programın menülerini iyi kullanabilmesinin yanısıra, 

doğru kararlarla doğru analizler yapabilmesi ve doğru çözümler üretebilmesi de gerekir.  Örneklere 

başlamadan önce, bu konunun önemini daha iyi anlamanız ve motivasyonunuzun artması açısından  

“Niçin CAE?” başlıklı alttaki yazıyı  okumanızı önemle tavsiye ediyorum. ANSYS Workbench’i yeni 

öğrenmeye başlayan tüm öğrencilere ve araştırmacılara faydalı olması dileğiyle… 

 

30 Ocak 2017 

Prof.Dr. Mehmet Zor 
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Bugün için endüstride kullanılması düşünülen 

makinelerin, mekanizmaların, sistemlerin veya 

farklı konstrüksiyonların üretime geçmeden önce 

bilgisayar destekli tasarımları (CAD - Computer 

Aided Design) yapılarak,  işlevselliği kontrol 

edilebilmekte; tasarlanan her bir parçanın 

bilgisayar destekli üretimi ( CAM - Computer 

Aided Manufacturing) gerçekleştirilebilmektedir. 

Ancak CAD-CAM faaliyetleri arasında, yapılması 

son derece önemli olan bir faaliyet daha vardır. Bilgisayar Destekli Mühendislik  (Computer Aided 

Engineering – CAE) olarak isimlendirilen ve sonlu elemanlar teorisine dayalı olarak geliştirilmiş 

paket analiz programları yardımıyla yapılan bu faaliyet, tasarlanan sistem veya mekanizmanın 

çalışma şartlarındaki durumunu sanal ortamda görmemizi, muhtemel problemleri tespit etmemizi, 

bunları giderici tedbirler geliştirmemizi ve daha verimli çözümler üretmemizi sağlar.    

CAE çalışmalarında daha önceden kurulmuş model ismi verilen ve incelenen sistemin geometrisini 

temsil eden sanal nesne, program tarafından otomatik olarak sonlu elemanlara ayrılabilmekte; 

üzerine çalışma şartlarındaki dış yükler, sınır şartları, malzeme özellikleri girdi olarak verilmekte, 

analizler ise program tarafından otomatik yapılmaktadır. Analizlerde karşımıza birçok sonuç 

(gerilme, şekil değiştirme, hız, ömür vb.)  sayısal veya görsel olarak çıkmaktadır. Daha sonra analiz 

sonuçları yorumlanarak muhtemel problemler tespit edilmekte, problemleri gidermek için CAD 

faaliyetlerine geri dönülerek tasarımsal revizyonlar veya farklı tedbirler geliştirilmekte, tekrar CAE 

faaliyetleriyle, yenilenen tasarımın analizleri yapılmaktadır. CAD ve CAE faaliyetleri arasındaki bu 

alışveriş tasarlanan sistemde sanal ortamda hiçbir sorun kalmayana kadar devam etmekte ve ancak 

bundan sonra CAM faaliyetleriyle herbir parçanın üretimine geçilebilmektedir.  

Arada CAE faaliyeti olmadan yapılan ve sadece CAD-CAM faaliyetleriyle üretilen parçalar çalışma 

şartlarında problem çıkarabilmekte, hasara uğrayabilmekte veya dayanım gibi problemleri 

giderebilmek için gereğinden çok fazla kalın veya hantal yapılabilmekte, bu ise  önemli ölçüde 

malzeme, maliyet, zaman ve işgücü kayıplarına sebep olabilmektedir. 
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Doğru bir CAE çalışması yapıldığı taktirde, tasarlanan yeni sistemin ilk prototipleri (üretilen ilk 

örnekleri) performans testlerinden de ilk seferde başarıyla geçmekte, bu ise işletmelere gerek 

zaman, gerek maliyet, gerekse işgücü açısından çok önemli kazanımlar getirmektedir. Doğru bir 

CAE faaliyeti yapabilmek içinse, analiz girdilerinin doğru belirlenmesi, sonuçların doğru 

yorumlanması ve bunların üzerinden doğru çözümler geliştirilmesi gerekir ki bu da ancak iyi bir 

mühendislik alt yapısı temelinde yapılabilir. O halde CAE faaliyetlerinde bir mühendisten, 

programın menüleri kullanmayı iyi bilmesinin yanısıra, analiz faaliyetlerini doğru yönlendirme 

becerisine sahip olması da mutlaka istenir. Örneğin sonuçları renkli olarak ekrandan 

çıkarabilmesinin yanısıra, bunları yorumlayabilmesi ve çözümler geliştirebilmesi beklenir. Karşısına 

çıkan birçok analiz sonuçlarından hangilerinin yorumlanması gerektiğini bir mühendis mutlaka 

bilmelidir. Bu ise bir mühendisin temel bilgilere yeterince hakim olması ile çok yakından ilişkilidir. 

Sünek malzemeler için asal gerilmeleri veya gevrek malzemeler için von-mises gerilmelerini 

yorumlayarak çözüm üretmeye çalışan bir mühendis hakkında “CAE çalışmalarını yanlış 

yönlendiriyor ve yönetiyor” denilmesi hiç de yanlış değildir. 

Ancak yeni mezun durumundaki birçok mühendisin okulda öğrendiği temel mühendislik bilgilerinin 

zihninde henüz ham halde olduğu veya bir kısmını unuttuğu görülmektedir. Ne zaman ki, bu bilgileri 

gerçek hayattaki problemlere uygulama durumu sözkonusu olursa bu bilgiler zihninde canlanmakta 

ve zamanla tam olarak yerleşmektedir. İşte CAE faaliyetleriyle sık sık haşir neşir olarak endüstrideki 

farklı problemlere çözüm üretmeye gayret göstermek, temel mühendislik bilgilerinin mecburen 

gerçek hayata uygulanması sonucunu doğurmakta ve mühendislik kalitesinin artmasına sebep 

olmaktadır. Bu haliyle CAE faaliyetlerini “bir mühendislik profesyonelleşme programı” olarak 

nitelendirmek hiç de yanlış olmasa gerektir. 

Günümüzde, profesyonel firmaların analizleri yapılmadan üretilmiş parçaları satın alımlarda 

tercih etmemesi,  CAE faaliyetlerinin ne derece önemli olduğunu ve işletmeler açısından artık bir 

güven kriteri haline dönüştüğü göstermektedir. 

Görüldüğü gibi CAE, günümüz endüstrisinde çok önemli bir yer teşkil etmekte ve bu faaliyetler ise 

şüphesiz mühendislerden beklenmektedir.  
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1. STATİK YAPISAL, ELASTİK GERİLME ANALİZİ Örneği 
 

Örnek Problem: 

Şekildeki elemanın alt kısmı alüminyum alaşımı, üst kısmı ise yeni bir malzemedir (E =30GPa , . Üst 

yüzeyine 100 MPa lık bir basınç, D noktasına ise toplam 471,7 N bileşke kuvvet;  bileşenleri Fx=150N, Fy=-

200N, Fz=400 N olacak şekilde uygulanacaktır.  Yan A ve delik içinB yüzeylerinden eleman sabitlenecektir. 

Bu durumda ortaya çıkan eşdeğer gerilmeler (von-mises gerilmeleri) bulunacaktır.   

 

 
 

Kesit Geometrisi      ilerleyen adımlarda girilecektir.                                                                  

 

Önce Ansys’e giriş yapıyoruz. 

 
 

 

 

 

•  
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1.1 MODELLEME  (1 – 93 Adımlarını sırasıyla yapınız.) 

 
 

Önce Analiz tipine göre proje oluşturalım. 

 
 
Model için Birim Sistemi seçelim. 
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Modelin kesitini  X-Y düzleminde çizerek  Extrude komutuyla uzatacağız .   

x-y düzleminin ekranda ayarlanması. 

 

 
 

Önce mouse kullanarak rastgele boyutta yukarıda gösterilen A1 ve A2 alanlarını çizelim ve kesiti genel hatlarıyla 

oluşturalım. 
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Noktaların veya çizgilerin yeri ve boyutu şu an önemli değil. 

 
 

Trim : Yatay ara çizgiyi kaldıralım. 
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Perpendicular : Dik çizgilerin ayarlayalım.  

 
 

 
 

Şimdi bu Şekli boyutlandırarak gerçek kesiti elde edelim. Önce çizgilere sembol (isim) atayalım. 

 

Alt yatay çizgiye sembol verilmesi. 
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Yan Dikey Çizgiye Sembol Verilmesi 

 
 

 

 

 

Benzer şekilde tüm yatay ve düşey çizgilere sembol veriniz. 

 

 

 
 

Sol alt menüden gerçek boyutları her bir çizgi sembolünün karşısına giriniz. Dikkat:  Sizin verdiğiniz sembol isimleri 

farklı olabilir.  
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Eğer sketch çok küçük kalırsa Zoom tuşlarını kullanın. 

 

 
 
Save the sketch 1. 

 

 

Sketch -1 isminde kaydedin.  
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Extrude Komutu ile Hacim oluşturma:  

Alltaki adımları numara sırasıyla takip ederek bu kesite 1000 mm bir derinlik verip uzatın. 
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Mouse’un orta tuşuna basarak sürükleyin ve üç boyutlu halde katı modeli görün. 

 

Kesite delik çizin. Bu katı modele de yansıyacaktır. 
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Deliğin konumu ve boyutunu ayarlayın. 

 
 

Fillet Komutu ile Köşeleri yuvarlatın (66 – 73) 
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Freeze : Şimdi hacmi  ikiye bölerek alt ve üst parçayı oluşturalım.(79-90) 
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Katı modeli extrude-1 ismiyle kaydedin. 

 

 

Mesh: Elemanlara Ayırma İşlemi  94-129 

Şimdi sonlu elemanlara ayırma işlemi ve sonra analizi yapacağız. 

Ekranın altında,  
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96 - ( )…             

 

 

97 ( ) 

 

Parçalara isim verin. (Upper part, lower part ) 
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Elemanlara ayırma (Mesh 102-129) 
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Ctrl tuşu ile her iki hacmi seçin ve yeşil gözüksün. 

 

Eğer hacim seçilemiyorsa yukarıdaki  tuşuna önce basın. 

Eleman tipi : Tetrahedrons seçilecek  …. >>  

Sizing komutu ile Eleman minimum boyutunu belirleyerek mesh sıkılığını ayarlayalım. 
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Element Size küçüldükçe elemanların boyutları küçülür, mesh sıkılığı artar. Yani model daha fazla elemana 

bölünür. Bu ise çözüm hasssasiyetini arttırır. Ancak Çözüm süresi uzar ve bilgisayarda daha fazla yer gerekir. 

Bazen bu sebeple bilgisayar kapasite yetmeyebilir. Optimum bir eleman sayısı yakalamak gerekir. 
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Kontak bölgesi için eleman büyüklüğü, 
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1.2 SINIR ŞARTLARI (BOUNDRY CONDITIONS) 

İncelenen yapının hareket sınırlamalarını tanımladığımız sınır şartlarını girmeliyiz. Sınır şartlarının yanlış 

tanımlanması sonuçların yanlışlığına sebep olacağından doğru girilmesi son derece önemlidir. 

(Bu örnekte Yan Kenarı ve Delik İçini Sabitleyeceğiz: Fixed Support, Cylindirical Support . Adımlar: 130-140) 
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1.3. DIŞ YÜKLER (LOADİING) 

Dış Yükleri Girelim (Yan Yüzeye Kuvvet, Üst Yüzeye Basınç girilecek. Adımlar: 141 -158) 

 

 

    

 

147 Ekranda basıncı görün 

 

Köşe noktaya tekil kuvvet girelim. 
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Nokta Seçilemiyorsa yukarıdaki (   ) simgesini 

tıklayın. 
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1.4 MALZEME ÖZELLİKLERİNİN GİRİLMESİ VE ATANMASI  (159 – 184) 

Bir tane programın veri tabanından malzeme (alüminyum) seçilecek ve üst hacme atanaca;  bir tane  yeni 

malzeme tanımlanacak ve alt hacme atanacaktır. Aşağıdaki adımları sırasıyla takip ediniz. 
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Ekran görünümü bozuk olabilir. Bu durumda aşağıdaki işlemi yapınız. (171-173) 

      

 

Elastik Yapısal Analizde Isotropik malzeme için sadece ( E Young modulus ve poisson’s ratio yeterlidir. 

 

Girilen Malzemeleri ve Özellikleri için Proje güncellemesi (177.adım) yapmakta fayda var.  
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Malzemeleri Hacimlere Atayalım. 

Üst hacme Yeni malzeme: 

 

Tanımladığınız Malzemeler görülmüyorsa bir kere (File >Refresh Data .. yapabilirsiniz) 

Alt hacme Alüminyum: 
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Artık Herşey hazır. Çözüm Yaptıralım 

 

 

1.5 Sonuçları Görelim. 
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(Veya öncelikle 191-194 adımlarından görmek istediğimiz sonuçları atayabilirdik.) 
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Sadece Üst Parçadaki Von-Mises Gerilme Dağılımını görmek istersek: 
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Bu projeyi “Elastik Statik.wbpj” olarak kaydedin. 
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2. STATİK YAPISAL, ELASTO –PLASTİK GERİLME ANALİZİ 
 

 

Aynı model, aynı yük ve aynı sınır şartları için üst parçaya Elasto-plastik bir yeni malzeme 

tanımlayacağız ve akma sınırını aşarak kalıcı (plastik) deformasyonları görmeye çalışacağız.  

 

 

 
 

 Eğer Bilgisayarınızı yeni açtı iseniz, daha önce kaydettiğiniz elastik_statik_analiz.wbpj 

dosyasını açınız  veya sıkıştırılmış halini  buradan indiriniz.  

 elastik_statik_analiz dosyasını açarken “Unlock veya Cancel” tercihli uyarı çıkarsa “Unlock” 

u tercih ediniz. 

 Hiçbirisini yapamıyorsanız öncelikle “Elastik Gerilme Analizi” örneğini baştan sona yapınız.  

 

 

Şimdi Alttaki adımları takip ediniz. (Gösterilen Simgeleri sırasıyla tıklayınız) 

 

2.1      

   

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

http://ansys.deu.edu.tr/wp-content/uploads/2017/02/elastik_statik_analiz_ansys14.rar
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2.2 Ekranın Görüntüsü 

 

 

 
 

 

2.3 Malzeme Özellikleri: Üst hacim new material-1 olarak kalsın. Alt Hacime Elasto Plastik bir malzeme 

tanımlayacağız. 
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2.4 Önce Elastik analiz için tanımladığımız new material-1 in aynısından bir malzeme daha elde edelim. 

 

 

 

 
 

 

2.5 Bu malzemeye Yeni isim verelim. Tek tıkla .. “elasto-plastic material” 
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2.6 Ekranın görünümü bozuk olabilir… Düzeltelim. 

 

 

2.7 Yeni malzeme için plastik bölgeyi tanımlayalım. 

Malzemenin E ve değerleri new material 1 ile aynıdır. İlaveten plastik bölge eğrisine ihtiyaç vardır. 

Plastik bölgesi de doğrusal olduğunu düşünüyoruz. Bu durumda, elastik ve plastik bölgesi 2 ayrı doğru 

ile tanımlanan Bilenar Isotropic Hardening malzeme seçeriz. 
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2.8 Dikkat: Bu madde Bilgi Amaçlıdır.  Alttaki komutları inceleyip, 2.9 maddesinden devam ediniz.  

a-) Bilinear malzeme özellikleri Sıcaklığa bağlı girilmesi gerekiyorsa: 

 

Not: Burada elastik bölge sıcaklığa bağlı girilmemiş. Onu da sıcaklığa bağlı girmek için Young Modülünün 

(E) Çeşitli sıcaklıklardaki değerleri ayrıca girilmelidir.  Young ve Tangent modülleri aynı sıcaklık değerlerinde 

tanımlanması çözümün hızlı yapılması için daha uygundur.  

 

b-) Plastik Bölge Eğrisel olması gerekiyorsa: Multilinear Isotropic Hardening 

 
 

c-) Plastik bölge Eğrisel ve Sıcaklığa bağlı ise: Multilinear Isotropic Hardening  

 
 

Not: Burada da Elastik bölge kısmı ayrıca sıcaklığa bağlı girilebilir.  

d-) Diğer plastik malzeme karekterine göre uygun olan seçilmelidir. 
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2.9)    mechanical modülüne geçiniz. 

Girilen Dataları güncelleyelim. 

 

 

2.10)  Üst Parça New Material-1 olarak kalsın.  

Alt parçaya “elasto plastic material” isimli malzemeyi atayalım. 

 

 

2.11) Dış Yükler : Mevcut dış yükleri aynen kullanacağız. 

İşlem ağacından bu yükleri (force ve pressure) bir kere kontrol ediniz. Eğer yoksa “1. Statik Yapısal, Elastik 

Gerilme Analizi” örneğindeki 141-158 adımlarını tekrar uygulayınız. (syf: 26-27) 

2.12) Sınır Şartları:Aynen kullanılacak. İşlem Ağacından Fixed Support ve Cylindircal Support u 

kontrol ediniz. Eğer yoksa “1. Elastik Statik Gerilme Analizi” ndeki 130-140 adımlarını tekrar yapınız.    

(syf: 24-25) 

2.13 ) Elemanlara Ayırma: Aynen Kullanılacak. İşlem Ağacından Mesh i kontrol ediniz. Eğer 

Elemanlara ayrılmamış ise “1-Elastik Statik Analiz” örneğindeki 94-129 adımlarını tekrar yapmalısınız.  
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2.14) Görmek istediğimiz sonuçları atayalım. 

Plastik deformasyona uğrayan kısımları görmek için “Eşdeğer Plastik Şekil Değiştirme” sonuçlarda mutlaka 

gözükmeli. Bunun için, 

Solution (right click)>Insert>Strain> Equvilant Plastic Strain 

 

  

Diğer sonuçları (Equvilant Stress, vb) benzer şekilde atayalım. 
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2.15) Sonuçları İnceleyelim. 

 

 

 

Bu sonuçlar 7. Maddede tanımlanan bilinear isotropic hardening malzeme karekteri için bulunmuştur. 

Diğer Sonuçları da inceleyiniz. 
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3. YORULMA (FATIGUE) ANALİZİ 
1 nolu ”Statik Yapısal, Elastik Gerilme Analizi” örneğindeki aynı model, aynı sınır şartları ve aynı yükler 

üzerinden yorulma analizi ile  ömür tayini yapacağız. Yükler  -F  ile + F arasında tekrar edecek.   

 

Yorulma ile ilgili Özet Bilgi:  

 Yorulma, Tekrarlı yükler altında malzemenin bir süre sonra hasara uğramasıdır. 

 Yükler statik uygulansaydı akma sınırı aşılmadığı sürece malzeme plastik deformasyona uğramaz ve 

kopma olmaz.  Ancak periyodik olarak tekrar ederse akma sınırı aşılmasa dahi, belli bir süre sonra hasar 

oluşur. Tıpkı kaldırabildiğimiz bir kutuyu tekrar tekrar kaldırıldığımızda, bir süre sonra yorulup 

kaldıramadığımız gibi, malzemelerde de tekrarlı yüklere karşı bu tip bir özellik vardır.  

 Yorulma olmaması için bir malzemenin minimum 106 tekrara kadar bu yükü taşıması gerekir.   

 Malzeme özelliği olarak ilaveten yorulma karekteristik eğrisi (S-N diyagramı) tanımlanmalıdır. Bu eğrinin 

anlamını iyi kavranmalıdır.  

 

Bir noktadaki tekrarlı yüklemede gerilme-zaman değişimi 

Şimdi yukarıdaki yorumları alttaki diyagramlardan tekrar anlamaya çalışınız. S-N diyagramının ne anlama 

geldiğini iyice kavramalısınız.   Soldaki diyagramı inceleyerek b, c ve d noktalarını yorumlayınız. 

  

Şu noktaları yandaki diyagramdan 

anlamaya çalışınız. 

1- Aynı ortalama gerilme (Sm) 

değeri için gerilme genliği Sa 

artarsa malzeme yorulması daha 

az tekrar sayısında gerçekleşir. 

2- Aynı Sa değeri için Sm azalırsa 

malzeme daha fazla tekrar 

sayısında yorulur. 

 Sonsuz Ömür Kavramı: S - N 

eğrisi 106 çevrimden sonra 

genellikle yatay eksene (apsis) 

asimptotik bir durum gösterir, 

yani  bu tekrar sayısından 

eğrinin yatay eksene paralel 

olduğu kabul edilebilir. Bu ise 

sonsuz ömür anlamına 

gelmektedir.  
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3.1 Yorulma Analizinin sonuçlarını görebilmek için öncelikle statik yapısal analizin tamamlanmış olması 

gerekir. Aşağıdaki şıklardan birisini tercih edin.  

 

a-) veya Eğer şu an elasto-plastik analiz adımlarını da bitirmiş iseniz, Alt Parçaya Aluminum 

Alloy  u tekrar atayınız (1.örnekteki 183-184. Adımlar) ve tekrar çözüm yaptırınız . Böylece 

Elastik Statik Analizi tekrar elde edeceksiniz. 

b-) veya Daha önce  kaydettiğiniz “elastik statik_analiz.wbpj” proje dosyasını açınız veya 

sıkıştırılmış halini buradan indiriniz ve açınız. 

c-) bunların hiçbirisini yapamıyorsanız 1 nolu “Elastik Yapısal, Statik Gerilme Analizi 

örneğindeki ” 1-202 adımlarını yapınız.  

 

3.2  

 
 

Ekran Görüntüsü 

 

 

 

 Statik analiz tamamlandı.  Şimdi Yorulma Analizine geçebiliriz. 

 

http://ansys.deu.edu.tr/wp-content/uploads/2017/02/elastik_statik_analiz_ansys14.rar
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3.3  Öncelikle Yorulma analizi için yeni bir malzeme tanımlayalım. Bundan maksat analizde gerekli 

malzeme özelliklerini görmenizi sağlamaktır. 

 

Engineering Data> Boş hücreyi tıklayınız. Yeni malzemeye new material for fatigue  ismi verebiliriz.  

 

 

 

a-) Elastik Özellikler 

  

 

 

 

b-) Plastik Bölge : Plastik Bölgeyi de tanımlamakta fayda var. Zira gerilmeler akma sınırı aşabilir. Aşmazda 

zaten elastik çözümle aynı olur. Plastik bölge tanımlanmamış olduğu halde akma sınırı aşılırsa sonuçlar yanlış 

olur. 
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c-) Yorulma Eğrisi (S-N diyagramı) nın tanımlanması 

S-N diyagramı: “Gerilme Genliği (Alternating Stress) – Hasar için Tekrar Sayısı” diyagramıdır.  

 

Ortama Gerilme (Mean Stress - Sm ) e göre S-N diyagramı değişir. (Yukarıda bilgi verilmiş idi.) 

 

   

 

Bu Tablonun anlamı:  

R-Ratio : Dış Yükün Değişim oranı.  

R-Ratio = -1 ise  dış yük  “-F  ile + F arası” değişiyor ;    

(R-Ratio = -2 olsaydı -2F ile +2F arası değişecekti.)  

(R- Ratio = 0 olsaydı 0 ile F arası değişecekti.) 

Cycles ( N ) : Tekrar Sayısı,  

Alternating Stress ( S ): Bu tekrar Sayısına Dayanabileceği Gerilme Genliği, 

(Veya başka ifadeyle bu gerilme genliğinde, yorulma olana kadar ki tekrar sayısı)  

R-Ratio =-1 ise bir noktada max = -min ve   m = 0;     

R-Ratio = 0 ise  bir noktada min = 0 ve m =max /2,  olduğunu görünüz. 
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R-Ratio = 0 için de S-N diyagramını giriniz: 

 

 

 

 

 

3.4) Sistemi yenileyin ki, yeni girilen malzemeler algılanmış olsun. 
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3.5 Üst parçaya Malzeme ataması 

 

 

 

3.6 Dış Yükler : Mevcut dış yükleri aynen kullanacağız. 

İşlem ağacından bu yükleri (force ve pressure) bir kere kontrol ediniz. Eğer yoksa “1. Statik Yapısal, Elastik 

Gerilme Analizi” örneğindeki 141-158 adımlarını tekrar uygulayınız. 

 

3.7. Sınır Şartları: Aynen kullanılacak.  

İşlem Ağacından Fixed Support ve Cylindircal Support u kontrol ediniz. Eğer yoksa “1.Statik Yapısal, Elastik 

Gerilme Analizi” ndeki 130-140 adımlarını tekrar yapınız. 

 

3.8.  Elemanlara Ayırma: Aynen Kullanılacak.  

İşlem Ağacından Mesh i kontrol ediniz. Eğer Elemanlara ayrılmamış ise “1.Statik Yapısal, Elastik Analiz” 

örneğindeki 94-129 adımlarını tekrar yapmalısınız. 
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3.9.   Yorulma analizi için “Fatigue Tool” tanımlanmalı 

 

 

 

 

 

Loading Ratio: -1  anlamı: Statik yükler (Force,  Pressure) bir negatif bir pozitif olarak tekrar edecek 

- Fmin  + Fmax ;    -pmin + pmax 

Fatigue Strength Factor (Kf): Çentik etkisi, sıcaklık vb. gibi faktörler yorulma ömrünü azaltır. Bu 

durumda yorulma mukavemetindeki düşüş bir katsayısı (Kf) ile ifade edilir. 0<Kf<1 

Scale Factor: Uygulanan yükün kaç katı uygulanacağını gösteren katsayıdır. 

Analysis Type: Elastic yüklemelerde Stress life, plastik bölgeye geçilirse Strain life seçilir. 

Stress Component: Ömür hesabnda kriter alınacak gerilmedir. Sünek malzemeler için Von-Mises, 

Maksimum Kayma Gerilmesi (Max. Shear Stress); Gevrek malzemeler için Maksimum asal gerilme 

veya Columb kriteri tercih edilir. 
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3.10 Yorulma Analizi Sonuçlarını atayalım. 

            

 

3.11. Çözüm yaptırın. Şimdi Statik Analizi tekrar çözdürün.  Yorulma Sonuçları da ortaya çıkacaktır. 

 

 

 

3.12. Sonuçları İnceleyiniz. 

 

 

3.13. Projeyi kaydedin.. File>Save As> statik + yorulma  
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4. KARARLI REJİM (STEADY-STATE) ISIL YAPISAL ANALİZ 

 

1 nolu Statik Yapısal, Elastik Gerilme Analizi örneğindeki, aynı model üzerinde kararlı rejim durumu 

incelenecektir. Delikten  250 C lik sabit sıcaklıkta bir akışkan geçmesi durumunda parçalardaki sıcaklık 

dağılımları ve Gerilme dağılımları incelenecektir. Yeni malzemeler ve yeni sınır şartları tanımlanacaktır. 

 

Kararlı Rejim (Steady-State) durumu nedir?  

 İncelenen sistemdeki herbir noktanın sıcaklığı birbirinden farklı olsa da sıcaklıklarda zamanla değişim 

yoktur.  Sistem kararlı durumunu zaman içerisinde korur.  

Şimdi aşağıdaki adımları sırayla takip ediniz. 

 

4.1 Katı Modelin Kurulması :  

 

Aşağıdakilerden birisini tercih edini:. 

a- Eğer yorulma analizinden devam ediyor iseniz, alttaki segmeyi tıklayınız 

 
b- Veya 1 nolu ornek için başta kaydettiginiz extrude dosyasını bilgisayarınıza indirerek 

açınız.  

c- Veya Extrude.rar dosyasını indirip aciniz  

d- Hiçbirini yapamıyorsanız ve model elinizde yoksa en baştaki 1.örnekte Elastik Statik 

analizin  1-101 adımlarını yapmalısınız. 
 

 

 

 

 

 

 

 

 

http://ansys.deu.edu.tr/wp-content/uploads/2017/02/extrude.rar
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4.2 Analiz Tipini sağ tuşla tutup, Geometri Üzerine Sürükleyip Bırakın 

 
 

4.3 “Model” i tıklayın

 

4.4 Meshing 
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4.5)  Malzeme Özelliklerinin girilmesi: Tekrar girmemizin sebebi bu analiz için gerekli özellikleri 

görmektir. 

 

 
 

 
 

4.5.1 Görünümü düzeltin 
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4.5.2 yeni malzeme girin. Alttaki ismi tanımlayın 

 
 

 

4.5.3 elastik özellikler 

 
 

 

a-) Sıcaklığa Bağlı Değilse (biz b şıkkını gireceğiz) 

 
 

 

b-) Sıcaklığa Bağlı İse ki, bunu gireceğiz. 

 

 
 

 

4.5.4 Plastik bölge özellikleri.  Bilinear tanımlayalım. 
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Sıcaklığa bağlı gireceğiz. 

 

 
 

4.5.5 Isı iletim katsayısı 
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a-) Sıcaklığa bağlı değilse..ki,  Biz bunu seçeceğiz. 

 
 

 

b-) Bilgi : Sıcaklığa bağlı olsaydı.. yine sağ üstten tablo oluşturacaktık 

 
 

4.5.6 Isıl Genleşme Katsayısı  

 
 

 
 

 

Sıcaklığa bağlı değişecek. Alttaki tabloyu oluşturun. 
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4.5.7) Reference temperature girin. Reference temperature,  sıcaklıktan dolayı şekil değiştirmenin 

olmadığı sıcaklıktır. Oda sıcaklığında cisimde sıcaklık sebebiyle şekil değişikliği olmadığı 

düşünüldüğünden Referans Temperature oda sıcaklığı (22 oC) alınacaktır.   

 

 
 

4.6 Üst Parçaya yeni Malzemeyi atayalım. 
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4.7 Dış yüzeylere taşınım katsayısı girelim. 
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4.8 İç deliğe sabit 250 C sıcaklık değeri girelim. Sanki delikten 250 C de sabit sıcaklıkta bir akışkan 

geçiyor gibi düşünüyoruz. 

 

 
 

 
 

 

4.9 Çözüm sonunda görmek istediğiniz sonuçları atayın. Önce Sıcaklık dağılımını atayın  
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4.10 Çözümü yaptırın. 

 
 

4.11) Sıcaklık Dağılımını inceleyin. 

 
 

4.12) Gerilmeleri de Görebilmek için Isıl Analiz Üzerine Statik Analiz Yaptırmamız gerekiyor.  

 
 

Mouse un sol tuşu basılı iken  Static Structural üzerine basılı iken, Mouse u Engineering Data Üstüne 

Sürükle, Mouse u bırakmadan  Geometri Model, Setup ve Results Üzerinde Sürükle, Kırmızı 

Çerçeveler gözüksün. Sonra Mouse u Bırak. 
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Alttaki şekil elde edilmeli.. (Static Structrual menüsünde soru işareti olan bir modül olmamalı) 

Bu şekilde termal analizin sonuçlarıyla yapısal gerilme analizi yapılacaktır. 

 

 
Şimdi Static Structural menüsünde “Model” butonunu tıklayıp Mechanical modülüne geçin 

 

4.13 Sınır Şartları: Alt Yüzeyi Sabitleyelim. 
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4.14 Görmek İstediğimiz Sonuçlar: Örneğin a-) Von-Mises gerilmeleri 

 

 
 

b-) Plastik şekil değiştiren kısımları görmek için “Eşdeğer Plastik Şekil Değiştirme” (Equvilant Plastic 

Strain” seçilir. 
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c-) Sadece Alt Parçadaki Von-Mises Gerilme Dağılımını görmek için; 

 

 
 

 

 
 

Dikkat: Alt parçayı Hide body yaparak sadece üst parçadaki sonuçları göremezsiniz. Hide body yine 

tüm sistemdeki sonuçları verir ama üst parçayı gösterir. Ancak bu c şıkkındaki işlemle sadece üst 

parçaya ait sonuçları görmeniz mümkün. 
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4.15 Çözüm Yaptıralım. 

 

 

4.16 Sonuçları İnceleyin. 

 
 

 

 

4.17 Projeyi Save As> “steady state thermal structural” ismiyle kaydediniz. 

Not: Sadece sıcaklık dağılımı için ısıl özelliklerin girilmesi yeterlidir. Ancak termal gerilmeleri de görmek 

istiyorsak E, , varsa plastik bölge eğrisi de girilmelidir.  
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5. ZAMANA BAĞLI (TRANSIENT) ISIL- YAPISAL ANALİZ 

 

Yine 1 nolu örnekteki aynı katı modeli kullanacağız.   

Bu katı modelin tümünün 250 oC lik fırının içinden bir anda oda ortamında soğumaya terkedildildiğini 

düşüneceğiz. Malzeme Özelliklerini yeniden gireceğiz.  Soğuma sırasında sıcaklıkların  ve gerilmelerin nasıl 

değiştiğini görmeye çalışacağız.  

Zamana Bağlı (Transient ) ısıl Analiz ne demektir?   

 İncelenen sistem veya parçanın herbir noktasının sıcaklığı farklı olabildiği gibi incelene süreç için herbir 

noktanın sıcaklığı zamanla da değişkendir. Bir fırından çıkarılan bir malzemenin soğuma süreci veya sıcak 

bir içeceğin soğuk bir bardağa koyulması durumunda bardağın ısınma süreci buna örnek olarak verilebilir. 

Isıl analiz tiplerinden hangisini seçmeliyiz?  

Hangisinde daha kritik durum sözkonusu ise o seçilmeli ve analiz ona göre yapılmalıdır. Bu ie tecrübe ve 

tahminle belirlenir. Örneğin, kalorifer borusunda en fazla genleşme ve dolayısıyla maksimum gerilme 

tamamen ısındığı son durumda olduğunu tahmin ederek kararlı rejim (steady-state) analizini tercih ederiz. 

Ancak soğuk bir ortamdaki cam bardağa sıcak bir çay doldurulduğu zaman birkaç saniye içinde kırıldığını 

biliriz ve bu durumda zamana bağlı (transient) analizi tercih ederiz. 

 

5.1  Katı Modelin Kurulması : Bunun için, aşağıdaki şıklardan birisini tercih ediniz. 

 

 

a-)  Eğer aynı modelle ilgili bir analiziniz açıksa alttaki segmeyi tıklayın 

 
 

b-) veya Extrude.rar dosyasını bilgisayarınıza indirerek açın.   

c-) veya En baştaki 1. Örnekteki 1-101 adımlarını yapınız ve modeli oluşturunuz.  

 

  

 

 

 

http://ansys.deu.edu.tr/wp-content/uploads/2017/02/extrude.rar
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5.2  Mouse un sol tuşu basılı vaziyette iken Transient Thermal çekip Geometri üzerine  bırakın. 

 
 

5.3 Elemanlara Ayırma: Alttaki kırmızı okla gösterilen butonları sırasıyla tıklayın. 
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Elemanlara ayrılmış model görünümü 

 
 

5.4 Malzeme Özelliklerinin Girilmesi 

 

Önce görünümü düzeltelim. 

 

 

 
 

Engineering  Data yı tıkladıktan sonra, Boş hücreye tıklayıp, yeni malzeme tanımlayalım. Ve new 

material for transient thermal ismi verelim. 
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a-) Elastik Özellikler (E ve )  

 

 

 
 

 

Sıcaklığa Bağlı gireceğiz. Bu tabloyu oluşturalım. 

 

 
 

b-) Plastik Özellikler bilinear ve sıcaklığa bağlı girilecek. 

 

 
 

 

 
Alttaki tabloyu oluşturalım. 
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c-) Isıl iletkenlik katsayısı 

 
Sıcaklığa bağlı değil. 

 
Bilgi: Sıcaklığa bağlı ise yine sağ üstten tablo oluşturulur. 
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d-) Isıl Kapasite Cp 

 
Sıcaklığa bağlı değil. 

 
Bilgi: Sıcaklığa bağlı olursa tablo girilmeli. 

 
 

e-) Yoğunluk d 

 
Sıcaklığa bağlı değil. 

 
Bilgi: Sıcaklığa bağlı olsaydı tablo oluşturacaktık. 
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f-) Isıl Genleşme Katsayısı (

 
 

 
 

Sıcaklığa bağlı gireceğiz. Alttaki tabloyu oluşturalım.  

 
 

g-) Reference temperature girin. Reference temperature,  sıcaklıktan dolayı şekil değiştirmenin 

henüz başlamadığı sıcaklık olarak düşünülebilir. Oda sıcaklığında cisimde sıcaklık sebebiyle şekil 

değişikliği olmadığı düşünüldüğünden Referans Temperature oda sıcaklığı (22 oC) alınacaktır.   
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5.5. Üst parçaya yeni malzemeyi atayalım. Alt parça çelik olarak kalacak. 

 

a-)   Mechanical a geç 

 

b-) Girilen malzeme özellikleri için Data ları güncelleyelim. 

 

 
 

 

c-) Birim ayarlarına tekrar bakalım. Metric (mm,kg,N,s mV,mA) seçelim. 

 
 

d-) Üst parçaya malzeme atayalım. 
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5.6 Dış Yükler: Dış yüzeylerin tümü hava ile temas edeceği için tüm dış yüzeylere (delik dahil) 

aynı taşınım katsayısını gireceğiz.  

 

 
 

 

 

 
 

Taşınım katsayısının biriminin  W/mm2 C olduğundan emin olmalısınız. 
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5.7 Initial Temperature (Başlangıç Sıcaklığı): Tüm cisim 250 oC de fırından çıkarıldığını 22 oC lik 

oda ortamında soğumaya terk edildiğini düşünüyoruz. Bu sebeple başlangıç sıcaklığımız 250 oC 

olmalıdır.  

 

 
 

5.8 Zaman Ayarları : Toplam 1000 sn boyunca soğumayı takip edeceğiz.  

İşlem Ağacından Analysis Setting e giriniz. 

 

 
 

Veya duruma göre farklı ayarlar yapılabilir. Ancak bu ayarlama iyi yapılamazsa program 

yakınsama yapamaz ve hata verebilir. Transient analizde en önemli noktalardan birisi bu 

çözüm zaman ayarlarını doğru yapabilmektir. 
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5.9. Sonuçları atayalım.  

Sıcaklık Dağılımını görmek istiyoruz. 

 

 
 

 

5.10.  Çözüm Yaptıralım 

 

 
 

5.11.  1000.sn (Son adımdaki) sonuçlar ekrana çıkar 
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5.12. Ara saniyelerdeki değerleri görmek için alttaki adımları numara sırasına uygun takip edin..  

 

 
 

124.22sn deki değerler aşağıdaki gibi ekranda çıkar. 
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5.13.  Isıl gerilmeleri hesaplamak için, aşağıdaki adımları takip ediniz. 

Not: Sadece sıcaklık dağılımını görmek isteseydik malzeme özelliklerine E,  plastik bölge eğrisi ve 

girilmesine gerek yoktu. k, d, Cp yeterli olurdu.  

 

5.13.1 Gerilmeleri görmek için Isıl Analizin üstüne Statik Structural analiz yapacağız. Önce Analizi 

atayalım.  

 Sağ tuşla Static Structural dan tutup ok yörüngesinde sürükleyin.  

 

Böylece tüm transient termal analiz modeli, girdileri ve sonuçları statik analiz içine dahil edilmiş olur. 

5.13.2  Sınır Şartları: Alt yüzeyi de sabitleyelim. 
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5.13.3  1000.sn deki sıcaklık dağılımını yük olarak verelim 
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5.13.4. Zaman ayarlarında statik analiz zamana bağlı olmayacak. Son saniye için çözülecek. 

 
Olmasına dikkat edelim. 

 

5.13.5 Von-Mises Gerilmelerini görmek için, 

 

 
 

5.13.6 Çözüm yaptıralım. 

 
 



Ansys Bilgi Havuzu (ansys.deu.edu.tr)     /    13.2.2017 

81 
 

5.13.7 Sonuçları Görelim.  

 
 

 

Static Structural menüsünde “Model” butonunu tıklayıp Mechanical modülüne geç. 

 

5.13.8 Sadece Üst Parçadaki Von-Mises Gerilme Dağılımını görmek için; 

 

a-) 5.13.5  adımından Equivalent Stress 2  atadıktan sonra alttaki sırayı takip ediniz. 

 
 

Dikkat: Alt parçayı Hide body yaparak sadece üst parçadaki sonuçları göremezsiniz. Hide body yine 

tüm sistemdeki sonuçları verir ama üst parçayı gösterir. Ancak yukarıdaki şekilde sadece üst parçaya 

ait sonuçları görmeniz mümkün. 
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 b-).  Tekrar Çözüm yaptırırız. 

 

 
 

Sadece üst parçaya ait gerilme dağılımı. 

 
 

 

5.14. Ara saniyelerde gerilme dağılımını görmek için: Örneğin 7.step olan 324,22.sn deki 

gerilmeleri görebilmek için alttaki adımları takip ediniz. 

 

a-)  
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b-)  

 
 

 

c-) 

 
 

d-)  
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e-)  

 

 

 

f-) 324,22 sn sonundaki Eşdeğer gerilme dağılımı 

 

 

5.15 . Ara saniyede sadece üst parçadaki gerilme dağılımını görebilmek için 3.18.8 ve 3.14 maddeleri 

birlikte yapılmalıdır. 

 

 

 

 



Ansys Bilgi Havuzu (ansys.deu.edu.tr)     /    13.2.2017 

85 
 

6. MODAL ANALİZ (Titreşim Analizi) 

 1.Örnekteki Aynı Geometriyi kullanacağız. Sınır Şartlarını Değiştireceğiz. Yükleri Kaldıracağız ve Bir 

Ucundan Ankastre Yaparak Doğal Frekansları Bulacağız. 

Çalışma Şartlarındaki frekansın doğal Frekanslardan birisiyle çakışması halinde Rezonans dediğimiz aşırı 

titreşim oluşur. Bu sebeple farklı modlardaki doğal frekansların belirlenmesi son derece önemlidir.  

 

 

6.1 Öncelikle  katı modeli kurmalıyız. Aşağıdaki şıklardan birisini tercih ediniz. 

 

a-)  Eğer aynı modelle ilgili bir analiziniz açıksa alttaki segmeyi tıklayın 

 
 

b-) veya Extrude.rar dosyasını bilgisayarınıza indirerek açın.   

c-) veya 1. Örnekteki 1-101 adımlarını yapınız ve modeli oluşturunuz.  

 

6.2 Mouse un sol tuşu basılı vaziyette iken Modal üzerinden çekip Geometri üzerine  bırakın. 

 
 

 

 

  

http://ansys.deu.edu.tr/wp-content/uploads/2017/02/extrude.rar
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6.3. Şimdi alt hacim paslanmaz çelik,  üst hacim ise başka bir elastik malzeme olsun.   

 

a-) Önce yeni malzemeyi tanımlayıp üst parçaya atayacağız.  

Engineering Data ya girin.. yeni malzeme tanımlayalım. Boş hücreye tıklayın ve aşağıdaki gibi isim girin. 

 

 

b-) Yoğunluk tanımlamalıyız. 
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c-) Elastik Özellikleri (E,  ) aşağıdaki gibi girelim. 

 

 

 

 

d-) 
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  açılır.  

 

e-) Önce malzeme özelliklerini mechanical kısmında güncellemekte daima fayda var. 

 

 

f-) Hacimlere isim verelim. (Top part and bottom Part) 
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g-) Üst Parçaya yeni malzeme atayalım. 

 

 

Not: Alt parçanın malzemesi çelik (structural steel) olduğunu kontrol ediniz.  (İşlem ağacında 

bottom part ı tıklayarak alt kısımda structural steel yazdığını görünüz.) Farklı ise aynı işlemle alt 

parçaya çelik malzemeyi atamayı unutmayın. 

6.4 Elemanlara Ayırma ( Meshing) 
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6.5 Sınır Şartları: Bir Uç Yüzeyi Ankastre yapacağız. 

 

 
 

 
 

6.6 Sonuçlara Toplam Deformasyonu Atayalım 
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6.7 Çözüm yaptıralım 

 
 

6.8 Altı mod için doğal frekansları görelim 

 
 

 

6.9 Şimdi herbir modda şekil değiştirme durumunu inceleyelim. 

a-) 

 
 

b-) Tekrar Sağ tuşla 
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c-) 6 mod için sonuçları görelim. 

 

 
 

 

 

6.10  Mesela 4.moddaki deformasyonu görelim.

 
 

6.11 Animasyon:  Örneğin mod 4 ü animasyon halinde görmek için 

 


